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“Learning gives creativity, creativity leads to thinking, thinking 

provides knowledge, and knowledge makes you great.” 

DEAR PARENTS, 

Holidays are the best time when you can connect with your child in many ways. These days 

are precious and valuable and can be made most from if wisely used. We should always 

remind ourselves that children will not remember us for the gifts we shower upon them but 

will always cherish the time we spent with them. Its time to nurture young minds, inculcate 

moral values and narrate family anecdotes to keep them in touch with their roots.  

    GENERAL GUIDELINES FOR THE PARENTS: 

● Take your child for a morning walk and talk about things you can see around. 

● Play indoor games with your child. 

● Let your child help around the house by doing small jobs like dusting, cleaning tables, filling 

water bottles and watering plants. 

● Encourage them to spend time with grandparents. 

● Communication will play a vital role in grooming the overall personality of the children. 

Converse with your child preferably in English. 

  



      

GENERAL INSTRUCTIONS TO BE FOLLOWED WHILE DOING HOLIDAY HOMEWORK 

● All subjects holiday homework should be done in the respective subject revision notebook/ 

main notebook (as per the instructions given by the subject teacher). 

● The child will be assessed for neat handwriting, presentation, creativity and submission of 

the work on time. 

● Prepare your ward for four English or Hindi thoughts related to education or inspirational 

stories with proper introduction for morning assembly. 

● Parents can be facilitators at home but the work should be done independently by the child 

in his/her own handwriting. 

● Make the students revise the syllabus of all subjects covered till date. 

● Students should try to do your written work regularly to enhance their writing power. 

● Fix up a time table for your ward to organize his/her daily routine like, watching television, 

playing with friends, studying etc. 

  

  

    Have a fun-filled, enthusiastic and productive summer break ahead. 

  

  

  

  

  

  

  

  

  

  



  

English 

  Q1.Read the paragraph and choose the correct options. 

Riya was a very kind girl. She loved helping others. One day, she saw a homeless man sitting near 

the market. He looked unhappy and hungry. Riya quickly ran home and brought some food for him. 

The man smiled and thanked her. Riya felt very happy. 

a) Riya was a kind / rude girl. 

b) The man was happy / hungry. 

c) Riya brought food / toys. 

d) The man smiled / cried. 

e) ‘Quickly’ means slowly / fast. 

Q2 Arrange the sentences. 

a) Some are countable nouns and some are uncountable nouns. 

b) We use many and few for countable nouns. 

c) Nouns are names of people, places, animals or things. 

d) We use much and little for uncountable nouns. 

e) Countable nouns can be counted. 

f) Uncountable nouns cannot be counted. 

Q3 Write a paragraph about your favourite cartoon character. 

Q4 Circle subject and underline predicate. 

a) Rohan plays football. 

b) The dog barked loudly. 

c) My mother cooks food. 

d) The birds are flying. 

e) Sita reads daily. 



 

Q5 Write C (Countable) or U (Uncountable). 

a) Sugar - 

b) Books - 

c) Water - 

d) Chairs - 

e) Milk - 

f) Apples - 

Q6 Fill with much / many. 

a) How ___ books? 
b) There is ___ milk. 
c) How ___ students? 
d) Too ___ water. 
e) ___ friends 

Q7 Change the gender. 

a) King - 
b) Boy - 
c) Tiger - 
d) Actor - 
e) Father - 

Q8 Fill in the blanks (Gender). 

a)A male lion is called a ______. 
b)A female horse is called a ______. 
c) A male peacock is called a ______. 
d)A female fox is called a ______. 
e)A male duck is called a ______. 

  

Note: Do the entire work neatly in your grammar notebook. 

  

 

 

 

 



  

 

                 ह िंदी 

 कार्य पत्रिका 1  

प्रश्न 1. पाठ 4,5 पढ़ो, शब्दार्य कॉपी में 

कऱो और र्ाद कऱो । 

प्रश्न 2. पूछे गए प्रश्ऩोों के उत्तर दीत्रिए   

क. गाोंधी िी का िन्म कब और कहाों हुआ? 

  

 ख.सोंसृ्कत के त्रशक्षक और फारसी के त्रशक्षक में क्या अोंतर र्ा ? 

 

ग. मातृभाषा के अत्रतररक्त और कौन सी भाषाएों  हमें सीखनी चात्रहए ? 

घ. पढने के सार्-सार् व्यार्ाम करना क्य़ोों िरूरी है अपने त्रिचार त्रिखखए। 

____________________________________________ 

प्रश्न 3 ररक्त स्र्ान भऱो 

  क.अपने_________ की मुझे त्रचोंता ह़ो रही र्ी। 

ख. खुिी हिा में घूमना__________ के त्रिए िाभकारी ह़ोता है। 

  ग. गाोंधी िी की माता का नाम____________ र्ा   

    कार्य पत्रिका 2 

 क. गुरुिी ने द़ोऩो ों रािकुमाऱो ों क़ो क्या सीख दी? 

 ख. अत्रनरुद्ध के राज्य में सुख क्य़ोों पड़ने िगा?  

  ग. अत्रमत ने दुश्मऩोों के त्रिए क्या ऱ्ोिना बनाई? 

 

 



 

 प्रश्न 2 ररक्त स्र्ान भऱो 

क.सभी_______की त्रनर्म़ो ों का पािन करते रे् 

 ख. ________ ने अत्रनरुद्ध क़ो भी काट त्रिर्ा । 

 ग. _________से छते्त पर पत्थर मारे । 

 घ. _______ अमृत का प्यार देखकर खुशी के मारे ऱो    पड़ा । 

                                            

                                          व्याकरण  

 

प्रश्न 4  क.त्रदए गए शब्द़ो ों के द़ो द़ो पर्ायर्िाची शब्द त्रिखें 

  अत्रि ______ ईश्वर______ आकाश_______ मछिी______ 

  कपड़ा________ त्रमि________ पहाड़________ सुबह______ 

ख भाषा और हिहि िर एक चार्ट  बनाएिं । 

 ग.इनके त्रिए समुु्िाची शब्द त्रिखखए 

अिंगूर िं का______  मधुमक्खियािं का______  हकताब िं का________  सैहनक िं का_______ 

 प्रश्न 5 (रचनात्मक िेखन) 

     क."त्रिश्व पर्ायिरण त्रदिस" त्रिषर् पर 100-120 शब्द़ोों का एक सुोंदर अनुचे्छद त्रिखे 

     ख.िि बचाओ पर एक प़ोस्टर तैर्ार कऱो  (A4size sheet) 

 प्रश्न 6. गािंधी जी का सिंहिप्त जीवन िररचय दीहजए फ र्  के साथ 

न र्: सिंिूर्ट ग्रीष्मकािीन अवकाश कायट ह िंदी प्रवृहि कॉिी में करना  ै । 

  

  

  

  

  

  



 

Maths 

Part A: Multiple Choice Questions (MCQs) 

Choose the correct answer. 

1.  4,568 + 3,279 = ?   

    a) 7,847   b) 7,737   c) 7,847   d) 6,847 

2.  Which number is 1,000 more than 6,845?   

    a) 5,845   b) 7,845   c) 6,945   d) 16,845 

3.  9,000 - 3,456 = ?   

    a) 5,544   b) 6,544   c) 5,654   d) 5,454 

4.  The difference between 10,000 and 4,789 is:   

    a) 5,211   b) 5,311   c) 6,211   d) 5,121 

Part B: True or False   

Write *T* for true and *F* for false. 

1.  5,432 + 2,168 = 7,600   _______ 

2.  When we subtract 0 from any number, the answer is 0.  _____ 

3.  8,456 - 8,456 = 1  _____ 

4.  Addition of 3,000 + 450 + 50 = 3,500  ____& 

5.  The sum of the smallest 4-digit number and the greatest 3-digit number is 1,999.  

________ 

Part C: Match the Following 

Match Column A with the correct answer in Column B. 

**Column A**                **Column B** 

1. 7,850 + 1,150                        a) 4,000 
2. 9,321 - 321                                    b) 6,755 
3. 5,000 - 1,000 .                      c) 9,000 
4. 3,245 + 3,510                        d) 9,000 
5. 10,000 - 4,231                        e) 5,769 

 



 

Part D: Find the Sum 

Add the following: 

1.  4,567 + 3,218 = ________ 

2.  2,879 + 5,134 + 926 = ____&&& 

3.  8,076 + 1,924 = ______ 

4.  6,543 + 2,357 + 1,100 = __ 

Part E: Find the Difference 

Subtract the following: 

1.  9,876 - 4,321 = *_*__ 

2.  7,000 - 2,845 = *_*__ 

3.  8,503 - 3,697 = *_*__ 

4.  10,000 - 6,239 = *_*__ 

Part F: Word Problems 

Solve and write the answer with statement. 

1.  A library has 3,485 storybooks and 2,796 textbooks. How many books are there in 

total? 

2.  A shopkeeper had 8,500 kg of rice. He sold 4,675 kg in a week. How much rice is 

left with him? 

3.  In a cricket match, Team A scored 4,256 runs in the season and Team B scored 

3,987 runs. How many more runs did Team A score than Team B? 

4.  Riya saved ₹5,750 in her piggy bank. Her brother gave her ₹1,890 more. She 

bought a toy for ₹3,425. How much money does she have now? 

Part G: Fill in the Blanks 

1.  6,789 + ________ = 7,000 
2.  _______ - 2,500 = 3,250 
3.  4,000 + 300 + 50 + 6 = _________ 
4.  The difference between 99,999 and 11,111 is _______ 
5.  If you add 1 to the greatest 6-digit number, you get _______ 

  



  

  

Science 

Ch-3 Adaptation in Animals  

A. Multiple Choice Questions: 

1. Adaptation helps animals to: 

a) Sleep.                b) Survive            c) Play  

2. Which animal is adapted to live in water? 

a) Camel.             b) Fish.                 c) Tiger 

3.What do fish use to breathe? 

a) Lungs.              b) Gills.                 c) Skin  

4.Which animal lives in cold regions? 

a) Camel.            b) Polar bear.      c) Snake 

5.Why do animals adapt? 

a) To look beautiful b) To survive in their habitat.  c) To run fast 

6. Which animal can live both on land and in water? 

a) Fish                   b) Frog.                 c) Camel 

B.Fill in the blanks: 

1. Adaptation helps animals to __________ in their surroundings. 

2.A camel has a hump to store __________. 

3.Polar bears have thick __________ to keep warm. 

4.Fish have __________ to breathe in water. 

5.Birds have __________ to help them fly. 

6.A chameleon changes its __________ to hide. 

7.A tortoise has a hard __________ for protection. 

8.Porcupines have sharp __________ to keep enemies away. 

C. Write True or False 

1.All animals live in the same type of habitat. 

2.A camel is adapted to live in the desert.  

3.Fish can live without water.  

4.Penguins are adapted to cold regions.  

5.Adaptation is not important for survival.  



 

 

D. Write the name of the organism next to its adaptation given. 

 

 

 

 

 

     Ch-4 Reproduction in Animals  

A. Multiple Choice Questions: 

1.Animals produce young ones through the process called: 

a) Digestion.   b) Respiration c) Reproduction 

2. The young one of a butterfly is called: 

a) Puppy.     b) Calf c) Caterpillar 

3.The young one of a frog is called: 

a) Caterpillar.        b) Tadpole c) Larva 

4. A baby animal that drinks milk from its mother is most likely: 

a) A bird 

b) A mammal 

c) A fish 



 

 

5. Why do animals reproduce? 

a) To sleep.  b) To grow bigger c) To produce young ones 

B. Fill in the blanks: 

1.Animals reproduce to continue their __________. 

2. Animals like hen and duck lay __________ 

3. A butterfly comes out of a __________. 

4. ______ is the hard outer covering of an egg. 

5. Birds sit on their eggs to _____ them. 

C. Classify the animals:  

Make two columns in your notebook and write 5 animals in each column. 

Eggs – laying Animals Animals that give birth 

  

  

  

  

  

  

D.1.  Roll No. 1-20 Draw and label the life cycle of a frog or butterfly. Use colors to 

make it neat and clear. Do this on A4 size sheet. 

2. Roll No. 21-40 Make a collage on A4 sheet of animals and their young ones. 

  

  

  

  

  

  

  

  

  



  

  

  

  

SST 

Q1. Answer the following questions 

1.Name the states  which are included in the Northern plains. 

   _____________________________________________ 

2. Name at least five tributaries of the Ganga river. 

 ________________________________________________ 

3.Name the main industries in the states of Northern plains. 

_______________________________________________ 

4. What are the occupation of people in the Rajasthan state? 

  _________________________________________________ 

Q2.Fill in the blanks 

   1.The Tangi sarees are very popular in ______________  

   2. Maithli  is mostly spoken in the________________ state. 

   3._____________ is the capital of Uttar Pradesh. 

   4. Mt Abu famous for_____________Temple. 

  

   Q-3. Tick(✓)the correct answers 

    1. The Thar desert is surrounding by which river in the west?  

     Sutluj (   )             Narmada (   )             Indus (   ) 

    2. Which crop is not grow in Rajasthan  

     Bajra (   )                 wheat (    )                jute (    ) 

   3. Which is not a popular folk dance of Rajasthan  

Ghoomar (   )          Bhangra (   )                    chari (    ) 

Q-4 One word answer:- 

 1. Chhath is the most popular festival in____________ 

 2. Amritsar in Punjab is famous for the____________ temple. 

 3. The capital of the Assam state is __________ 

 4. The Bhakra Dam is built on the _____________ 

  
   



  

  

 

 

Q-5. True or false 

1.The Western desert in India is also called the third desert (    ) 

  2. Most of the sand dunes in the Thar desert are outside the desert area (    ) 

  3. Da dilwara Jain Temple is in Jaipur (    ) 

  4. Oases Are found in almost every part of the Thar desert (    ) 

  

  

Q-6. Activity work 

1. Write 7 Continents and 5 Oceans and learn it. 

2. Make a poster on A3 size sheet on the the"Say No Plastic" or "Save Water"with     

    Slogan. 

  

 3.(Historical places) paste picture of any 4 famous historical places of India like Taj Mahal, 

Red fort and right five sentences about them in notebook. 

  

  

  

  

  

  

  

  

 

 

 

 

 

 



 

 

FRENCH 

  

Q.1 Écrivez les nombres de 1 à 10 en français.(Write 1-10 countings in french.) 

Q.2 Écrivez la signification des mots donnés.(Write the meaning of the given words.) 

a) À bientôt - 

b) Bonne nuit - 

c) Comme çi comme ça - 

d) Au revoir - 

e) À plus tard - 

f) Bonjour - 

g) Bon après midi - 

h) Bonsoir - 

i) À demain - 

j) Mademoiselle - 

  

NOTE :- DO THE GIVEN WORK IN FRENCH NOTEBOOK. 

  

PROJECT BASED ACTIVITY:- 

• Prepare alphabets chart in French. 

Instructions : 

• Use A3 sheet. 
• Draw or paste a suitable picture for each alphabet. 
• Use different colors to make the chart attractive. 

• Decorate the chart with a border using colors or glitter sheet. 

• Keep your work neat, clean, and well-organized. 

• Ensure all 26 alphabets are correctly written. 

  



  

  

 

  

Computer 

 Worksheet-1 

A. Tick (✓) the correct option. 

1. Which of these is not a standard view option in Windows File Explorer? 

a. Tiles              b. Gallery                  c. Details 

2. To insert a table in MS Word, you click: 

a. Insert → Table          b. File → New            c. View → Table 

3. To combine several selected cells into one larger cell in MS Word, you choose: 

a. Merge cells.            b. Insert cell.              c. Split cell 

4. In PowerPoint, you add a new slide by clicking: 

a. Delete Slide.        b. New Slide           c. Duplicate Slide 

B. Write ‘T’ for True and ‘F’ for False statements. 

1. Files with the same name can be saved in the same folder.____________ 

2. Recycle Bin permanently deletes files immediately.______ 

3. Superscript will make the text appear above the regular line of text._______ 

4. You can insert a YouTube video directly into PowerPoint.________ 

C. Fill in the blanks. 

1. Deleted items are first placed in the __________. 

2. In MS Word, rows and columns form a __________. 

3. To paste a copied file, press Ctrl + __________. 

4. A __________ shows visual effects between slides. 

D. Match the following. 

Column A Column B 

1. Details view      a. Divides one table cell into multiple rows or columns 
 

2. Split cell b. A pre-designed set of colours, fonts, and layouts 
 

3. Cell shading d. File Explorer that shows file name, size, type, and date 
 

4.Theme e. Colour applied to a table cell background 



  

  

F) competency based questions  

a) you are helping your teacher organise a list of student names and mark in an MS 

word file with teacher will you use to display names and mark Nicky in rows and 

columns?  

b) A students marks table already contain 20 rows .The teacher now need a new row 

between rows 5 and 6 for a late admission student and wants to highlight the 

students marks in yellow describe how you will insert the row and format only that 

row. 

c) otherwise designing a presentation for the science project and wants every slide 

to have the same background and textile for a neat and uniform look .What should he 

apply? 

d) Anaya wants to make her presentation exciting by having a slide appear with a 

different effect during a presentation . What should she apply. 

Lab Activity – Powerpoint  

Create a presentation on food drops insert images and apply formatting.  

Objective:- to help student identify and categorize different types of food based on 

their functions in the body and present the information creatively using PowerPoint 

this activity and harms digital presentation skills formatting abilities and promotes 

understanding of balance nutrition.  

 Research about food crops and write an incline  

 Open PowerPoint  

 Slide one title  

 Click the title box and type  “Food Groups”. 

 Slide 2 : fuel for fun: Energy – Giving Foods 

 Add a new slide with the title box fuel for fun energy giving food  

 Insert image  

 Change font to robot font size to 15 point colour to red.  

 Slide 3 : Grow strong: Body building foods 

 Add a new slide with the title box glow song bodybuilding foods.  

 Insert image  

 Change font to robot to font size to 15 point colour to red.  

 Slide 4 : Shield Up : Protective Food 

 Add a new slide with the title box shield a protective foods  

 Insert image  

 Change font to roboto, font size to 15 point, colour to red 

  

  



  

  

 

Art 

🔹Make a A3 size blank  greeting card with the use of colourful pastel sheet and waste material. 

🔹Complete your art book work till pg.no. 15. 

Activity : 

Q1. Daily Yoga Practice  

Practice any five yoga poses daily for at least 15–20 minutes for 10–15 days. 

Write the names of the yoga poses you practiced. (A4 size sheet) 

  

 

 

 

  

Q 2. On the occasion of Father’s Day, make a beautiful greeting card for your father. Write at least 5–6 

lines expressing your love and gratitude towards him. Decorate it creatively using colors, drawings, or 

craft materials. 

  

  

  

  

  

  

  



  

 

 

GK 

Noted:- Do write given current affairs in your general knowledge notebook and learn them. 

  

Geography & Environment 
 

Q: Which country hosted the COP30 climate conference? 

A: Brazil 

Q: Which river recently became the focus of a major water-sharing dispute between India and 

Bangladesh? 

A: Teesta River 

Q: Which desert is expanding due to climate change concerns in Africa? 

A: Sahara Desert 

Q: Which country launched a large-scale reforestation project in the Amazon in 2025? 

A: Brazil 

Q: Which Indian state recently reported the discovery of new lithium reserves? 

A: Jammu and Kashmir 

🔹 

Science & Technology 
 

Q: Which space agency launched the Artemis II mission? 

A: NASA 

Q: What is the name of India’s first solar mission? 

A: Aditya-L1 

Q: Which company developed the GPT-5.3 AI model? 

A: OpenAI 

Q: Which country successfully tested a reusable spaceplane in 2025? 

A: China 

Q: What technology is central to the development of quantum computers? 

A: Quantum Mechanics 

Q: Which planet is known as the Red Planet? 

A: Mars 

Q: What do plants need to make food? 

A: Sunlight, water, air, and chlorophyll 

Q: Which gas do humans breathe in? 

A: Oxygen 

Q: What is the name of India’s space agency? 

A: ISRO (Indian Space Research Organisation) 

Q: Which device is used to see distant objects? 

A: Telescope 

 

🔹 

 

 



 

 

 

 

 Sports 

Q: Which country won the ICC Men’s T20 World Cup 2024? 

A: India 

Q: Who won the men’s singles title at Wimbledon 2025? 

A: Carlos Alcaraz.  

      Q: Which sport is played at Wimbledon? 

A: Tennis 

Q: How many players are there in a cricket team? 

A: 11 players 

Q: Which country won the ICC Men’s Cricket World Cup 2023? 

A: Australia 

Q: What is the national sport of India (commonly believed)? 

A: Hockey 

Q: Which game uses a shuttlecock? 

A: Badminton 

 

 

General & Geography 
 

Q: What is the capital of India? 

A: New Delhi 

Q: Which is the largest continent in the world? 

A: Asia 

Q: Which river is called the lifeline of Egypt? 

A: Nile River 

Q: Which is the tallest mountain in the world? 

A: Mount Everest 

Q: Which country is famous for the Great Wall? 

A: China 

🔹 

 

🔹 Politics & Current Affairs 

Q: Who is the Prime Minister of India (2026)? 

A: Narendra Modi 

Q: What is the name of the President’s house in India? 

A: Rashtrapati Bhavan 

Q: What do we call a group of people who make laws in India? 

A: Parliament 

Q: On which day do we celebrate Independence Day in India? 

A: 15th August 

Q: What is the national flag of India called? 

A: Tiranga 
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